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Introduction  
  
Understanding the requirements of an aquaculture application, researching the availability of a 
proposed area, and preparing well-drawn maps of your aquaculture application will assist in the review 
and assessment of an application. Please review the pre-application recommendations in the guidebook 
to assist you in the application process:   
  
https://www2.gov.bc.ca/gov/content/industry/crown-land-water/crown-land/crown-land-
uses/aquaculture 
 
This guidance document provides some basic steps to help determine the availability of an area. These 
instructions are to provide a quick look at existing interests in your application area. Once an application 
is submitted, a much more in-depth review is done by the appropriate Provincial and Federal agencies.  
  
The guidebook also shows how to get information about the application area, how to create and print 
four of the required maps, and how to create shapefiles and save them to your computer for the 
application area using iMapBC. Please note that different maps are required for different aquaculture 
application forms so please check your application form to find which maps are required.  
  
Further information on iMapBC’s functionality and tools are available through the iMapBC website 
found on the BC Geographic Data and Services webpage found here.  

The polygon shape created in this document is purely for instructional purposes and does not reflect any 
particular Crown land application or tenure in existence.  
   
   
    

  

  

  

  

  

  

  

  

  

http://www2.gov.bc.ca/gov/content?id=F093C05122144E11B6D6FECA3D6FE580
https://www2.gov.bc.ca/gov/content/industry/crown-land-water/crown-land/crown-land-uses/aquaculture
https://www2.gov.bc.ca/gov/content/industry/crown-land-water/crown-land/crown-land-uses/aquaculture
https://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
https://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
http://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
http://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
http://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
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Section 1: IDENTIFYING EXISTING INTERESTS IN A PROPOSED AREA  
  

Before submitting an application for an aquaculture facility, it is important to review the application 
area. This includes identifying the ownership and any encumbrances (conflicts or constraints) in the 
proposed area as well as nearby areas.   

There are several databases available to research interests in a proposed area:   

Natural Resources Online Services (NROS):  
 

 https://portal.nrs.gov.bc.ca/web/client/home https://portal.nrs.gov.bc.ca/web/client/-/mapping-

tools  

iMapBC: 
   

http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc  

Marine Plan Partnership for the North Pacific Coast (MaPP):  

  http://mappocean.org/  

 
A)    Locate the Area of interest in iMapBC  

Open iMapBC at http://maps.gov.bc.ca/ess/hm/imap4m/  

i) Find an area by zooming to it  

Navigation tools are found in the Home tab.   
 

 

 Use the Pan Tool to move around the map while using the mouse wheel to zoom 
in and out  

Use the Zoom In and Zoom Out tools to draw a box around an area you want to  
zoom to  

  

https://portal.nrs.gov.bc.ca/web/client/home
https://portal.nrs.gov.bc.ca/web/client/home
https://portal.nrs.gov.bc.ca/web/client/home
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
https://portal.nrs.gov.bc.ca/web/client/-/mapping-tools
http://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
http://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://mappocean.org/
http://mappocean.org/
http://maps.gov.bc.ca/ess/hm/imap4m/
http://maps.gov.bc.ca/ess/hm/imap4m/
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ii) Search by address or geographic name  

 

You may select a specific scale by clicking the  scale   symbol   at the bottom of the screen.    

With scale, the bigger the number the more area you can see. 1:5,000 may show part of a bay,  
while 1:125,000 may show the entire bay and surrounding area.     
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Enter in a geographic name or address in the top right search bar. Click on the magnifying glass to 
view the results of the search on the left side of the screen.   

 

Click on a result to zoom to that area 

iii) Find an area by coordinates  

Open the Home tab and look at the Zoom To options   

                 

  

  

  
Select Lat/Long, Albers or UTM and fill in the coordinates in the left hand menu.   
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iv) Locate area by District Lot or Survey PIN  
 

 

B) Add Provincial Spatial Layers  

Once you have located your area of interest, you can add spatial layers to show how the land is 
currently being used and what encumbrances (conflicts and constraints) may exist.   

 i)  How to add layers  

Open the Data Sources tab and click Add Provincial Layers to open up the layer catalog.   
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The catalog will open to display major categories of spatial information. By clicking on the + 
symbols, you can open sub-layers to add. Scroll down the layer catalog to find the Land 
Ownership and Status folder.   
 

 

Press the + beside Land Ownership and Status, scroll down to Crown Tenures by Purpose - 
Tantalis and press the + beside that. Add a check mark to Tenure Applications by Purpose – 
Tantalis – Colour Themed and Tenures by Purpose – Tantalis – Colour Themed. Press OK to 
display the layers. This will show where other people have started applications or are currently 
using public land and for what general purpose.    
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Example: Tenure Applications and Tenures in Baynes Sound  

 

In this example, there are a number of aquaculture tenures and applications that already exist; 
you would need to apply for public land outside these tenures. Similarly, you cannot apply to use 
private land or Crown land that is dedicated for another purpose such as parkland.  
  
These are the minimum recommended layers you should turn on when exploring and drawing 
your area of interest.  These layers are: 

Administrative Boundaries 

        o Provincial Parks, Eco Reserve, etc. – Tantalis 

 Provincial Parks, Eco Reserves and Protected Areas – All – 

             Tantalis- Colour Filled  

 National Parks – Colour Filled  

Base Maps  

 o Local and Regional Greenspaces 

 Local and Regional Greenspaces – Colour Filled 
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Land Ownership and Status - existing interests in public land  

 o Crown Tenures by Purpose -Tantalis  

 Tenure Applications by Purpose – Tantalis - Colour Themed  

 Tenures by Purpose – Tantalis – Colour Themed 

        o Integrated Cadastral Fabric – surveyed and titled parcels on Crown and private land  

 Integrated Cadastral Fabric – Outlined  

 Integrated Cadastral Fabric – Private Ownership 

          o Land Act Survey Parcels – Tantalis – for drawing your shape boundary  

 Land Act Survey Parcels – Tantalis – Legal Descriptions  

 Land Act Survey Parcels – Tantalis – Outlined  

Parks Recreation and Tourism 

  o National Parks 

 National Parks – Colour Filled  

  

The spatial layers listed below will be helpful in answering questions on your aquaculture 
application. For example, finding which regional district your area of interest is in. These layers 
are: 

Administrative Boundaries 

    o ABMS – Municipalities 

 Municipalities – ABMS – Outlined 

    o ABMS – Regional Districts 

 Regional Districts – ABMS – Outlined 

  o Indian Reserves including Band Names 

 Indian Reserves including Band Names – Outlined 
- to identify how close your application is to First Nation’s 

Reserves  
Base Maps 

      o Base Mapping – 20K 

 Water – River, Canal, etc. – Outlined – 20K 

- This layer can be used to help you draw your boundary if 
there are no survey lots or cadastral lines in your area of 
interest. 
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Land Ownership and Status 

    o Integrated Cadastral Fabric  

 Integrated Cadastral Fabric – Private Ownership 

 - identifies upland owners with riparian rights  

o Land Act Surveyed Rights of Way Parcels- 

      Tantalis 

 Land Act Surveyed Rights of Way Parcels – Tantalis - Outlined 

Checking through these layers may save you time and effort in your application because they will 
show where you can and cannot apply as well as what special authorizations you may need to apply for.   

 ii)  How to find more information about an area  

Once you have your layers added, you can get information from them (query them) by right 
clicking and selecting Find data on the map   

 

 
 

The menu on the left will change to Identify Results, by clicking on one of the results, you can get 
more details. In this case, the area of interest is within the Powell River Regional District.  
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In the Find tab you will see more advanced options, like the polygon tool, for finding data. Please 
see the iMapBC Training Manual under the heading “Reference Materials” for more detailed 
instructions.  
 

 

  

  

https://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
https://www2.gov.bc.ca/gov/content?id=C52F8C3BFE8C4110A63171337F363F43
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The more layers you select the busier your map will be and the more results you will identify. 
You can manage this by hiding layers that you aren’t currently interested in. You can hide layers by 
unchecking them in the layer menu on the left side of the main screen.   
 

 

 

 

 

 

 

 

 

  

  

Selected from layer  
catalog, but won’t  
be displayed   until  
checked   
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Section 2: CREATE REQUIRED MAPS   
  
Section 1 provided direction on how to add provincial data layers to see if there are any existing 
encumbrances in or near your application area. Once an available area is found, the next step is to 
create the required maps for your specific application. You may create these maps using any software 
you are comfortable with, as long as they meet the application requirements. This guide shows how to 
use iMapBC as the mapping software. Please refer to Section 4 for instructions to print these maps.  

A) Create the Application Area Map   
  

Before drawing your shape, notice the differences between the Integrated Cadastral Fabric (ICF), 
the Survey Parcels and the Terrain Resource Information Management (TRIM) base in the picture 
below. These differences are due to the way the data was collected and when.   
  
When drawing your application area, you should match the edge of your shape to the edge of the  
Land Act Survey Parcel. If there are no survey parcels in your area, then align to the Integrated 
Cadastral Fabric (ICF). If neither of those two layers exists in your area of interest, then align your 
shape to the (1:20,000) Water – Rivers, Canals, etc… layer, also known as TRIM lines.   
  

 

 
  
  

  

Edge of ICF   
  

Edge of Survey Parcels   

Edge of TRIM   
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To create the application area map, you will be using the tools found in the Sketch tab.  

 

Select the Polygon  tool and click once at a corner of your area of interest. Every click 
puts down a point (vertex) which you can change later if it’s in the wrong place. When you have a 
complete shape, double click at the last location to finish the shape.  

 

 

  
After finishing your drawing, if you would like to see the points (vertices) again, click on the Edit                                   

 

  

  

  

  Vertex   

…………… tool and then click on the  shape.   The vertices will  be   small dark circles   as in the  picture  
above.   
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While using the Edit tool, you may add more vertices by clicking, holding and dragging the little 
white circle shown between vertices. You can also change existing vertices by clicking and 
dragging them.  

 

To end the edit of the polygon, click on in the Markup tab.  

  
Your application area map requires a Point of Commencement (POC), a reference point to help 
you describe your shape in words. Section 3 and Appendix A for a more detailed description.   

When you are finished drawing your shape, you should pick a corner to be used as your POC. Right 
click on the corner of your shape and select “Draw a Point”.   

 

You can right click near the POC and select “Add Some Text” to add a “POC” label. To change the 
position of the point or modify the text you can use the Edit Tool. You can then increase the size 
or change the colour of the text or point using the Style tools.  

  

Example of creating a vertex   
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A sample application area map  

  

See more detailed reference guides at: http://www2.gov.bc.ca/gov/content/data/geographicdata-
services/web-based-mapping/imapbc  for guides on how to change the colours and patterns in layers as 
well as turn on layer labels.   

                                                                                   

http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
http://www2.gov.bc.ca/gov/content/data/geographic-data-services/web-based-mapping/imapbc
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B) Create an Amendment Application Area Map  
  

If you are submitting an amendment to your existing tenure, you will need to create an 
amendment map following the same procedure as in Section 2 Part A “Creating an Application 
Area Map”.   An additional step however is to first make sure to have your Crown Tenures layer 
turned on so that you can see your existing tenure. This way you can match the edges of your 
existing application to your proposed amendment.   

Be sure to label the tenures with the             tool to make it clear which is the amendment and 
which is the existing tenure.  

  
Sample Amendment Map  
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C) Create the Detailed Location Map   
If your application type requires a “Detailed Location Map” (Part I of application), you may ‘zoom 
out’ from your application area map you created. Change the scale to between 1:20,000 and 
1:40,000. In this example the scale was set to 1:35:000.   
 

 

Example Detailed Location Map  
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D) Create the General Location Map  
  

Using the Application Area Map or the Detailed Location Map, you may zoom to a scale of 
1:100,000 to create the General Location Map.     

For this map, you do not need to see the base layers required on the application area map. Turn 
off extra layers by clicking on the Data Sources tab, then click My Layers and unselect all layers, 
your shape should be the only layer visible on the base map.    

  

 

At this scale, you may not be able to see your shape. To draw attention to where your area of 
interest is you can right click on your site location, and select Draw a Point. Use the Edit tool and 
the Style menu to change the colour, size and shape of the point to something that stands out.   

                     

  

  

Change scale here   

Uncheck boxes   
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You can export or print the map using the steps found in Section 4 of this guide. This will allow you 
to produce something like the map below.   

Example General Location Map  
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Section 3: CREATE METES AND BOUNDS OR CORNER POINTS DESCRIPTION  
  

As noted in the application form, the application area map needs to be accompanied by either a 
shapefile or metes and bounds. Section 5 explains how to use iMapBC to create a shapefile.   

Metes and bounds (distance and direction) describe the location of a parcel by beginning at a well-
defined point (point of commencement) and following the boundaries in a clockwise direction.  
See Appendix A for a more detailed explanation of Metes and Bounds.   

It is not possible at this time to create a true metes and bounds using iMapBC. However, recording 
the coordinates of the Point of Commencement and corner points of your application is also 
acceptable. 

Required information for application:   

• Point of Commencement (POC)  
o This is a coordinate that will be used as a starting point to describe where your 

area is and its dimensions. If possible, the POC should be the corner of a known 
surveyed lot: “South West corner of DL 225, Sayward District”  

o The POC can be also described in relation to corner point of a surveyed lot:      
“20m west of northwest corner of DL 7178, New Westminster District”  

  
• The coordinates of your vertices (corner points) and length in metres of the edges of the 

shape  

            OR  

• Metes and bounds  
  

Please record the coordinates/metes and bounds in a separate document. When your proposed 
area is drawn using more advanced software, there may be minor changes in coordinates or side 
lengths.  
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Example of Corner Points Document  
 

 

 

 When creating a Metes and Bounds or Coordinates sheet, make sure to note which direction you 
are listing your points from i.e.  POC to A to B to C is clockwise, or East from POC to A   
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A) Find Coordinates by Identifying the Corner Points of a Drawn Shape  
  

Once the application area has been drawn, you find the coordinates of a point on the map using 
the Plot Coordinates tool found in the Home tab, and then left click on a point of interest.   

 

 

 
Using the Plot Coordinates menu on the left, you can change the format of your coordinates, 
(Decimal Degrees, Decimal Minutes, Albers, UTM, etc.), delete labels or enter your own 
coordinates by clicking on the 3 dots. You can hide or delete all coordinate labels by clicking on 
the bar icon:   

  

  

  

Finding coordinates   of  corner points   
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New applications require you to give the GPS coordinates for the centre of the application area. 
For an amendment to an existing application, you need to record the centre of the combined 
existing and proposed areas.    

When you have identified the coordinates, record the information on a separate document.  

The map you submit with your application must not have coordinates visible.  

B) Determine the Length of Sides and Area  
  

As well as corner points, you are asked to list the length of segments and the area (in hectares) for 
the proposed area boundary.   

 
Click on the Sketch tab, click on the Area tool then click on Enable Snapping. Click on a corner 
point and trace your drawing clicking on corner points. To finish your measurement, double click 
the left mouse button.  

On the screen, you will see the length of each line as well as a box showing the total area. Record 
this information on a separate document. The measurement units can be changed by clicking the 
down arrow in the Measurement box. For example the units in the picture below have been set as 
metres and hectares.  

 

                  

Chan ge or enter  
coordinates   

Hide or delete  
coordinates   
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keep the distance labels on the map. The Province will compute more accurate distances after 
finalizing your proposed area in the provincial spatial database.   

 

 

 

 

 

 

 

  

  

  R ecord the  area and  segment lengths on the   document with the coordinates but do not   
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Section 4:  PRINT A MAP ‘ 
 
  The Export tab contains different ways to share your map and drawings.  

 

The Print button creates a complete map as a standalone file such as a Pdf, Tiff or Jpeg. This 
option allows you to change the print resolution, add a mapping grid, change title and more. This 
is the simplest way to submit a complete map if you are a new iMapBC user.   

  
Remember to give your map a title as noted in the application i.e.  “Detailed Location Map”.  

 

If saving as a PDF, click “Open File” when the Print Request window shows. Your PDF may open 
inside your internet browser. Move the mouse cursor to the bottom of the screen to display a tool 
bar and then click the icon that resembles a floppy disk to save it to your hard drive.   
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Section 5: CREATE AND SAVE SHAPE FILES   
  
As outlined in the application form, it is recommended to create and submit a shapefile along with 
the required maps. Shapefiles are common spatial files manipulated with programs like ArcMap, 
QGIS and MapInfo. Submission of a shapefile may facilitate the review of the application.  

Select the Export tab and click Save Markup as Shapefile  

 

The tool will automatically create a Polygon shape file and have it compressed as a Zip File. If you 
are using Google Chrome the following screen will be displayed. Press OK to save it to your 
computer’s download folder.  
 

 

In Internet Explorer:  
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Go to the folder containing your shapefile, depending on your operating system and versions it 
may look like the picture below. If you are submitting the .zip file as part of an email submission, 
then the zip extension will need to be renamed. i.e. “Extract.zip” to “Extract.zap”.   

The Province of BC has firewalls to reject .zip files.  

You can also send the individual shapefiles. To do this you need to extract them from the zip 
folder. Right click on the file you downloaded to ‘unzip’ or ‘extract’ the file.   

  
If you cannot unzip the file, you may need to download an extraction program such as  

7-Zip : https://www.7-zip.org/  

WinZip: http://www.winzip.com/win/en/  

This is a picture of the contents of “Export.Zip”. Click extract to save the files to a folder on your 
computer to send them with your application.   
 

 

  

  

  

  

  

  

  

  

  

  

https://www.7-zip.org/
https://www.7-zip.org/
https://www.7-zip.org/
https://www.7-zip.org/
http://www.winzip.com/win/en/
http://www.winzip.com/win/en/
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Appendix A – Metes & Bounds Description  

Metes and Bounds description of the application area if unsurveyed:  

• All descriptions for an unsurveyed application site should be tied to a known survey point, 
usually the corner of a survey lot. The first point of the description is known as the Point of 
Commencement (PoC). If the location of your parcel of interest is too remote and there are no 
surveyed parcels in the vicinity, then the POC can be the GPS coordinates of one of the corner 
points of your area of interest.  

• Metes and bounds descriptions should be described in a clockwise manner with the PoC being 
the first position on the shoreline of the unsurveyed parcel.    

  
Guidelines for drawing shapes  

• As a rule of thumb, make your shape rectangular if possible, with sides being parallel to each 
other and perpendicular to the general trend of the shoreline.  Draw the seaward side parallel 
to the general trend of the shoreline.   

 

• Unless you are intending to use upland (ie building a shed), then make sure your shape does 
not overlap the upland. This means aligning the edges of your shape to the 
survey/Cadastral/TRIM lines so it is clear that your intention is to use only the foreshore.  

• In narrow bodies of water, you must leave space for boats to navigate through. Draw your 
shape so that it does not extend the entire width of a navigable body of water.   
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Appendix B – Example Maps  

General Location Map  
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Detailed Location Map  
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Application Area Map 
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Amendment Application Area Map  
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Corner Point Description (to accompany the application area map)  
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Metes and Bounds Description (to accompany the application area map)  
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